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Введение 
 

В настоящей методической разработке, предназначенной для 

студентов направления подготовки 08.04.01 «Строительство» даны 

материалы и рекомендации по выполнению лабораторных работ по 
дисциплине «Математическое моделирование». 
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1. Математическое моделирование в строительстве.  

Реализация математических моделей в системах для решения 

математических и инженерных задач.  

Математические модели, включающие в себя набор 

алгебраических уравнений. Методы проведения расчетов и 

анализа моделей. 

 

Предварительно необходимо ознакомиться с основными 

понятиями, задачами математического моделирования в книге [1]. 
Рассмотрим способы реализации математических моделей на 

ЭВМ в современных программных комплексах для решения 

инженерных и научных задач. 
В работе познакомимся с системой для инженерных и 

научных расчетов «Maple» - разработкой канадской фирмы 

MapleSoft (www.maplesoft.com). Данный программный комплекс 
был создан университетом г.Ватерлоо (Канада) и применяется во 

многих учебных, научных и проектных организациях по всему 

миру. Это одна из ведущих систем подобного рода (Maple, 
MathCAD, MatLAB, Mathematica, SciLab).  

Maple позволяет строить математические модели, проводить 

их исследование, отображать модели в наглядном графическом 
виде, и осуществлять численные расчеты с использованием 

разнообразных математических моделей. Одно из достоинств 

данной системы - это возможность осуществлять моделирование не 
только в численном виде, но и при необходимости, в общем - 

символьном, аналитическом. Кроме того, в Maple имеется огромное 

количество встроенных алгоритмов, позволяющих вести 
вычисления с использованием численных методов. 

Данная работа посвящена знакомству с базовыми 

возможностями системы Maple. Дополнительный материал по этой 
системе можно почерпнуть в книгах [2], [3], [4]. 

 

Порядок выполнения работы 

Для выполнения лабораторной работы №1 необходимо: 

1. в каждом пункте работы изучить вводную часть (она 
записана обычным шрифтом); 

2. выполнить задания, выделенные жирным курсивным 

http://www.maplesoft.com/
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шрифтом; 

3. После выполнения всех заданий сохранить файл Maple и 

выслать его на проверку преподавателю. 
 

1.1 Основные действия с файлами Maple. 

Цель первой лабораторной работы – познакомится с базовыми 
возможностями этой системы, применяемыми при проведении 

простейших инженерных расчетов по готовым формулам. 

Научиться приводить расчетный файл к оформленному, готовому 
для печати виду. 

Создание нового файла в Maple осуществляется нажатием на 

кнопку на панели инструментов  или через меню: 
File>New>Worksheet mode. При этом в настройках программы 

(меню Tools>Option…, закладка Interface) в пункте «Default format 

for new worksheets» должен быть выбран вариант «Worksheet».  

Задание: создать новый файл. 

Открытие файла осуществляется при помощи кнопки  или 

через меню: File>Open… 
Сохранение файла осуществляется при помощи кнопки  

или через меню:  File>Save (сохранить) или File>Save 

as…(сохранить как…). 
Выполнить расчет сформированного расчетного файла можно 

при помощи кнопки . Если выполняется повторный расчет, то 

перед ним рекомендуется стирать в памяти результаты 
предыдущего расчета кнопкой . 

На экране исходные данные, формулы и результаты 

выделяются различными цветами. Исходные данные и формулы 
выделены черным цветом, результаты вычислений – синим. 

Для окончательного оформления и распечатки расчетный 

файл может быть сохранен в формате текстового редактора Word. 
Для этого необходимо выбрать в меню: File>Export as… В 

открывшемся окне установить Files of type (тип файла): Rich Text 

Format (.rtf). 
Если в Maple одновременно открыто несколько документов, 

переключение между ними, удобно осуществлять при помощи 
закладок, расположенных сверху (рис.1). Закладка отображаемого в 

текущий момент на экране файла выделена синим цветом. При 
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необходимости файл можно закрыть при помощи креста, 

расположенного на соответствующей закладке. 

 
Рис. 1. Закладки файлов 

 

1.2 Структура расчетного файла Maple. Командные и 

текстовые строки 

Файл состоит из набора командных строк (Execution Group). 
Командная строка начинается символом «>» красного цвета и 

ограничевается прямоугольной скобкой черного цвета слева. 

 
Рис. 2. Командная строка 

Как правило, в каждой командной строке набирается по одной 
формуле (или выражению, команде) для осуществления 

вычислений. Однако, возможен и набор нескольких выражений в 

одной строке. В этом случае они разделяются друг от друга точкой 
с запятой («;»). 

 
Рис. 3. Командная строка с двумя выражениями 

Для ввода специальных математических символов, 

обозначений и выражений можно использовать панели, 

расположенные в левой части окна программы (рис.4 а). Наиболее 
часто используемые математические выражения представлены на 

панели «Expression» (рис.4 б). 

Закладки  
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а)   б)  

Рис. 4. Панели для ввода математических обозначений, символов и, 
выражений. 

 

Для раскрытия/скрытия нужной панели необходимо сделать 
щелчок по кнопке с ее названием. В открытой панели можно 

выбрать нужное выражение или обозначение для вставки его в 

командную строку. Сиреневым цветом в выражениях обозначены 
параметры, которые необходимо заменить своим выражением или 

обозначением. После замены они приобретают нормальный, 

черный цвет. Для перехода от одного параметра к другому удобно 
использовать клавишу Tab. 

После ввода выражения(ний) и нажатия клавиши Enter на 

клавиатуре система анализирует командную строку и пытается 
вычислить ее. Результат отображается синим цветом если строка 

правильно воспринята системой (см. рис. выше). Если система не 
смогла правильно воспринять выражение(ния), в строке результата 

появится сообщение с ошибкой сиреневого цвета и исходное 

выражение с выделением части, не воспринятой системой (рис.5). 
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Рис. 5. Командная строка с ошибкой в исходном выражении  

(недопустимо применять после знака «+» знак умножения). 
 

Правее результата вычисления появляется его номер, который 

назначается системой автоматически (см. рисунки 2, 3). В 
дальнейшем его можно использовать для ссылки на полученный 

результат вычислений. 

Задание:  

1. ввести «a + b + b» и нажать Enter. В результате должна 

отобразится строка синего цвета с результатом «a + 2 b». 

2. ввести «a*+b+b» и нажать Enter. В результате должна 

отобразится строка с ошибкой. 

Для создания комментариев, пояснений к проводимым 

расчетам в Maple предусмотрены специальные текстовые блоки. 
Они отличаются от командных строк отсутствием символа «>» 

(рис. 6).  

 
Рис. 6. Текстовый блок  

Для создания текстового блока необходимо нажать кнопку в 

виде буквы «Т» на панели инструментов или клавиши Ctrl+T для 

преобразования текущей строки в текстовую. В текстовой строке 
можно использовать кнопки для выравнивания текста в строке, 

настройки вида, размера шрифта на панели инструментов. 
В текстовых строках можно набирать и сложные 

математические выражения, но они не будут вычисляться так, как 

это происходит в командных строках. Для переключения на ввод 
математических выражений в текстовой строке служит кнопка 

«Math» расположенная на панели инструментов или сочетание 

клавиш Ctrl+R. Для продолжения ввода текста после 
математического выражения необходимо нажать кнопку с 

надписью «Text» на панели инструментов или клавиши Ctrl+T. 

Задание: ввести в строке текст: «Формула: 
b

a
», в котором 

присутствует математическое выражение 
b

a
. 
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В процессе ввода командных строк новые строки для ввода 

появляются автоматически после нажатия клавиши «Enter». Однако 

иногда возникает необходимость вставить строку посередине уже 
существующих строк. Для этого необходимо установить курсор на 

соседнюю строку и для вставки пустой строки выше нее нажать 

сочетание клавиш Ctrl+K, ниже - Ctrl+J. 
Для удаления строки используется сочетание клавиш 

Ctrl+Delete. 

Задание: вставить две пустых строки ниже  и выше текстовой 

строки. Затем удалить одну пустую строку выше. 

1.3 Основные элементы математических выражений в 

Maple 

Базовые элементы выражений: 

1. Число (number) – может быть целым или дробным. 

Десятичные дроби записываются с разделителем–точкой, а не 
запятой! Т.е. две целых четыре десятых записывается как «2.4», а 

не «2,4». 

Задание: ввести выражение 1,5+0,5. Вычислить результат. 
2. Неизвестная величина (name)– может быть одной буквой 

или набором букв (словом). В обозначении неизвестной величины 

могут присутствовать цифры. Могут быть использованы буквы 
русского алфавита, греческие буквы. Допускаются обозначения с 

нижним индексом.  

Примеры написания обозначений неизвестных величин: «A»,  

«Var»,  «K23», «Парам», «1», «σ1». 

Для ввода нижнего индекса необходимо после ввода основных 

символов нажать на клавиатуре Shift + «-» (символ «_»). При этом 
курсор опускается ниже основного уровня строки. После ввода 

содержимого индекса, для возврата на основной уровень строки 

необходимо сдвинуть курсор клавишей «стрелка вправо» на 
клавиатуре. Так, для ввода обозначения «A1» необходимо нажать на 

клавиатуре: «А», Shift + «-», «1», «стрелка вправо». 

Для ввода греческих букв можно использовать панель 
«Greek», расположенную в левой части окна программы (рис. 7).  

При вводе неизвестных величин следует иметь ввиду: 
1. Maple различает регистр букв (большие/малые буквы). Т.е. 

неизвестные величины, записанные как «а» и «А» воспринимаются 
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Maple по-разному. 

2. Некоторые обозначения используются системой для своих 

целей и их нельзя использовать в качестве неизвестных. Например, 

это обозначения «D», «», «I», «». Обозначение «D» в Maple 

используется в качестве символа дифференциального оператора,  

«» – в качестве константы Эйлера (число 0.5772157...), 

«I»обозначает мнимое число i в комплексных числах, «» - число 

пи (число 3.14…). Нельзя так же использовать в качестве 

обозначений неизвестных величин названия стандартных 
математических функций – sin, cos и т.д. 

3. В выражениях могут использоваться обозначения с нижним 

индексом, но в расчетах нельзя использовать одновременно одно и 
то же обозначение с индексом и без него, например «А» и «A1».  

Однако, при необходимости, можно обойти 

вышеперечисленные ограничения, используя возможность, 
описанную ниже. 

В Maple имеется возможность формирования сложных и 

нестандартных обозначений неизвестных величин. Например, 
можно записать и использовать в качестве неизвестной величины 

обозначение: , или
  

и т.п. Для этого необходимо из 

символов, вводимых с клавиатуры или при помощи панелей, 
расположенных в левой части окна (рис.4) сформировать нужное 

по внешнему виду обозначение. При этом можно использовать 

верхний и нижний индексы, надстрочные и подстрочные 
выражения, которые вводятся сочетаниями клавиш «Shift + 6», 

«Shift + -», «Ctrl + Shift + ‘», «Ctrl + ‘» соответственно. 

Затем, необходимо выделить сформированное обозначение, и, 
нажав правую кнопку мыши, выбрать пункт «2D Math > Convert to 

> Atomic Indetifier». В результате этот набор символов будет 
восприниматься Maple как нечто единое целое. В любом 

выражении, где это сложное обозначение используется, 

необходимо набирать его точно таким же образом, как было 
описано выше, или скопировать и вставить в текст уже имеющееся, 

набранное обозначение. 

Применяя такой способ ввода обозначений, можно обойти 
ограничение на использование обозначений с индексами, когда это 
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не допускается (о чем говорилось выше), использовать обозначения 

«D», «», «I», «», «sin». В этих случаях, введя обозначение, 

необходимо так же его выделить и включить пункт Atomic Indetifier 
в меню. 

Задание: ввести в отдельных строках следующие обозначения 

неизвестных величин: 

λсредн 

 

 
3. Константа – это число, имеющее буквенное обозначение. 

Наиболее часто используемые в расчетах константы - , e. Для 

ввода констант можно использовать панель «Common Symbol» в 

левой части окна программы (рис. 7). 
4. Математические операторы. 

Основные из них – это операторы сложения, вычитания, 

умножения, деления и возведения в степень. Первые четыре 
представлены знаками «+», «-», «*», «/» и вводятся с клавиатуры 

соответствующими кнопками или соответствующими кнопками на 

панели «Common Symbol» в левой части окна программы (рис.7).  

     
Рис. 7. Панель «Greek» и «Common Symbol». 

 

Кроме того, вместо знака умножения можно набирать пробел. 

Т.е. выражения, записанные как:  «4*5» и «4  5» для Maple одно и 
тоже. 



12 

При нажатии на кнопку «/» на клавиатуре операция деления 

всегда отображается в виде дроби. Для отображения этой операции 

в одну строку можно использовать символ «/» на панели «Common 
Symbol» (рис. 7).  

Для ввода степени используется верхний индекс, который 

включается нажатием на клавиши Shift + 6 (символ «^»). После 
ввода значения степени на основной уровень текста можно 

вернуться, сдвинув курсор клавишей «стрелка вправо» на 

клавиатуре. Так же операцию возведения в степень можно ввести 
при помощи панели «Expression» (рис. 4 б). 

5. Функция (function) – это такие операции, как извлечение 

корня, логарифма, производной, вычисление синуса, косинуса и 
т.п. Наиболее распространенные функции можно ввести при 

помощи панели выражений «Expression» (рис. 4 б). 

Практически все функции записываются в виде: 
НазваниеФункции(параметр) 

Скобки здесь обязательны. 

Пример: «sin(x)», где sin – название функции, x – параметр. 
В литературе часто принято записывать функции без скобок. 

Например, «sin φ», «ln 10». Однако таким образом записывать 

выражения в Maple нельзя. Необходимо их переписывать как 
«sin(φ)», «ln(10)». 

Основные функции представлены на панели «Expression» в 

левой части окна программы (рис. 4 б). 
Основные математические функций в Maple записываются как: 

sin(x) – синус угла; 

cos(x) – косинус угла; 
tan(x) – тангенс угла; 

cot(x) – котангенс угла; 

arcsin(x) – арксинус; 
arccos(x) – арккосинус; 

arctan(x) – арктангенс; 

arccot(x) – арккотангенс; 
ln(x) – натуральный логарифм; 

log10(x) – десятичный логарифм; 
log[b](x) - логарифм с основанием b; 

exp(x) – экспоненциальная функция (можно набрать при помощи 
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панели «Expression» в виде «e
x
». 

 

Более сложные выражения в Maple формируются на основе 
четырех базовых элементов – чисел, обозначений неизвестных 

величин, констант и математических операторов. Основные 

выражения Maple это: 
1. Формула (algebraic expression) – набор операций, таких как 

сложение, вычитание, деление, умножение, возведение в степень, 

над цифрами, неизвестными величинами, константами, и 

функциями. Пример: sin( x)+2.345 (b+c). 

После ввода формулы в командную строку и нажатия кнопки 

«Enter», Maple пытается вычислить или упростить ее. 

Задание: записать выражение: « » 

2. Уравнение (equation)– математическое выражение, в котором 
имеется знак равенства. Например: «a + b = 10 с – 25», «x+y+6=0». 

После ввода уравнения в командную строку и нажатия кнопки 

«Enter», Maple пытается вычислить или упростить выражения, 
записанные в левой и правой частях от знака равно. 

3. Последовательность (sequence) – числа, неизвестные 

величины, константы, функции, формулы, уравнения, записанные 
друг за другом через запятую.  

Пример: «a, b, 10, 23+d». 

4. Список (list) – последовательность, записанная в квадратных 
скобках. Например: «[a, c, d+1]». Часто используется для 

разделения нескольких последовательностей, идущих друг за 

другом другом. 
5. Множество (set) – последовательность, записанная в 

фигурных скобках. Назначение множества – описать набор чисел, 

величин, функций, математических выражений, формул. Пример 
множества: «{c, d+4, 67}».В множествах порядок следования 

выражений Maple может менять самопроизвольно. Для Maple во 

множествах воспринимает только содержимое. Последовательность 
перечисления не воспринимается в отличие от списков. 

Задание: записать список чисел [1, 5, 3, 5] и множество { 1, 5, 3, 

5} в отдельных строках. Сравнить результаты вычисления 

этих строк. 
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6. Матрица, вектор – набор чисел, неизвестных величин, 

констант, функций, формул, записанных в форме матрицы или 

вектора. Создать матрицу или вектор можно при помощи панели 
«Matrix» (рис.8). 

 
Рис.8 Панель «Matrix». 

 
Указать размерность создаваемой матрицы можно численно, 

при помощи пунктов «Rows» (кол-во строк), «Columns» (кол-во 

столбцов), или в графическом виде, нажав и удерживая кнопку 
«Choose…». Для создания вектора необходимо указать число строк 

или столбцов равным единице (вектор – частный случай матрицы).  

Вставка матрицы в текст осуществляется кнопкой «Insert 
Matrix» («Insert Vector» для векторов). В результате, в строке 

появляется шаблон матрицы или вектора. Выделенные сиреневым 

цветом обозначения необходимо заменить своими значениями. Для 
перехода от одного элемента к другому можно использовать 

клавишу «Tab». 

Задание: записать в отдельных строках матрицу  и 

вектор . 

7. Процедура – некоторая команда, записанная в  виде:  

название команды(последовательность параметров команды),  
выполняющая определенное действие над математическими 

выражениями. Каким образом будет работать команда, и к какому 

(каким) выражению она будет применяться, задается в 
последовательности параметров команды. Для каждой процедуры 

последовательность своя. Например, процедура с названием 
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«solve», решающая уравнения, для решения уравнения «2 x
2
+10=0» 

будет записываться как:  

«solve(2 x
2
+10=0, x)». В последовательности параметров этой 

команды первым записывается решаемое уравнение «2 x
2
+10=0», 

вторым – искомая величина «х». 

Задание: ввести в командной строке выражение «solve(2 

x
2
+10=0, x)» 

Вывод результатов в виде десятичных дробей 

Система Maple при вычислении математических выражений с 
целью сохранить высокую точность расчетов обычно не сокращает 

дроби и не вычисляет значения корней, тригонометрических, 

логарифмических и др. функций. Однако все практические расчеты 
обычно заканчиваются результатом, имеющим вид числа. Для 

получения результата в виде обычных десятичных чисел, в  Maple 

используется специальная процедура «evalf», записываемая в виде: 
evalf(математическое выражение). 

Пример: «evalf(25/35)» выводит результат в виде 

«0.7142857142857», в то время как если просто ввести выражение 
«25/35», будет выведено значение: «25/35». 

Задание: получить численный результат вычисления формул: 

sin(/3), , 36/5+8. 

1.4 Использование результатов из командных строк в 

дальнейших вычислениях 

Для этого в Maple предусмотрены следующие возможности: 

1. сослаться на полученный результат по его номеру. 
Необходимо нажать на клавиатуре клавиши Crtl+L и ввести номер 

строки, содержащий нужный результат. Номера отображаются 

правее результата в скобках. 
Пример: результат вычислений под номером 12 используется 

в командной строке, изображенной на рис. 9 

 
Рис. 9 Использование результатов вычислений ссылкой на строку. 

 

2. Можно запомнить результат под любым именем (присвоить 
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имени). В этом случае необходимо использовать оператор 

присвоения «:=» в строке, результат вычисления которой 

планируется в дальнейшем использовать. Слева от оператора 
присвоения пишется имя, которому присваивается выражение, 

справа – вычисляемое выражение.  

Например, если записать «a := 10+30», то под именем «a» 
запомнится результат вычисления выражения «10+30», т.е. 40. 

Следует различать выражение с присвоением и уравнение. 

Так, выражения «a:=10» и «a=10» воспринимаются системой по-
разному. 

Для использования результата, сохраненного под именем, 

необходимо указать его в вычисляемом выражении.  
Например, если записать: «a := 10+30», то под именем «а» 

сохранится результат 40. Затем, записав выражение «а + 10»,  

получим 50,где вместо «а» будет подставлено число 40. 
Проверить, что было сохранено под тем или иным именем 

можно, записав его в новой командной строке и нажав «Enter». 

Задание: 1. ввести выражение «10-5*5.8». Появится результат 

вычисления строки: «-19.0». В следующей командной строке 

сложить этот результат с числом «123», используя ссылку на 

номер строки. 

2. ввести выражение «10-5*5.8», сохранив результат 

вычислений под именем «t». В следующей командной строке 

сложить этот результат с числом «123» используя имя «t» 

результата. 

Вывести в отдельной строке результат, сохраненный под 

именем «t». 

1.5 Подстановка значений в математические выражения 

При использовании присвоений результатов имени (см. 

выше), происходит автоматическая подстановки значений в 
выражения, где это имя встречается. Однако в этом случае нет 

возможности управлять этим процессом.  

Поэтому более предпочтительным и управляемым способом 
подстановки значений в математические выражения является 

использование процедуры «subs», которая записывается в виде: 
subs(равенство1, равенство2,…, ВычисляемоеВыражение) 

Здесь равенство1, равенство2,…- последовательность равенств, в 
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левой части которых записывается обозначение подставляемой 

величины, в правой – ее значение; ВычисляемоеВыражение – 

основное выражение, в которое осуществляется подстановка. 
Пример: «subs(a=10, b=c+d, a*25-b)» – процедура подставляет в 

выражение a*25-b значения a и b, которые равны: a=10, b=c+d. В 

результате получаем «250-c-d». 

Задание: в отдельной командной строке ввести уравнение 

«s=sin(x) (d-h)». В следующей командной строке при помощи 

команды subs подставить в это уравнение значения 

неизвестных: x=/3, d=10, h=2.5 

1.6 Создание графиков 

Вставка пустого графика функции осуществляется пунктом в 
главном меню программы: Insert>Plot> 2D – для формул, 

зависящих от одной неизвестной величины и Insert>Plot>3D – для 

формул, зависящих от двух неизвестных. Если число неизвестных 
величин в функции более двух, вывод графика невозможен. 

Для создания графика необходимо выделить математическое 

выражение, которое представлять собой функцию от одной или 
двух переменных (неизвестных величин), и «перетянуть» его на 

график, не отпуская левую клавишу мыши. При этом в 

математическом выражении не должно быть знака «=», т.е. 
выражение не должно быть уравнением. Для построения графика 

на основе уравнения необходимо выделить одну из его частей - 

расположенную левее или правее значка «=» и «перетянуть» ее на 
график. 

Для правильного отображения графика необходимо 

отрегулировать границы изменения аргумента функции и ее 
значений. Для этого в случае построения 2D графика необходимо 

выделить его и нажав на нем правую кнопку мыши, выбрать пункт 

Axes>Properties… 
В верхней части появившегося окна (рис.10), необходимо 

выбрать соответствующую ось (Horizontal Axis – горизонтальная 

ось, Vertical Axis – вертикальная ось). Отключить пункт «Use data 
extends» и в полях «Range min», «Range max» ввести начальные и 

конечные значения, отображаемые вдоль этой оси. 
Для 3D графиков необходимо после нажатия правой кнопки 

мыши выбрать пункт Axes>Range… Окно настройки осей графика 
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выглядит, как показано на рисунке 11. Настроить границы 

изменения значений по каждой оси можно выбрав 

соответствующий пункт под строкой «Default». 

 
Рис. 10 Окно настройки осей 2D 

графика 

 
Рис. 11. Окно настройки 

осей 3D графика. 

Задание: ввести выражение «sin(x) х+0.5» в командной строке. 

Вставить 2D график в строке ниже. Отобразить набранное 

выражение на графике. Установить границы отображения 

графика по горизонтальной оси от 0 до 2. Посмотреть на 

результат. Установить границы по вертикальной оси от -50 до 

50. 
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2. Математические модели, включающие в себя  системы 

линейных алгебраических уравнений. Прямые и итерационные 

методы их решения. 

 

1. Общие сведения о линейных алгебраических уравнениях 

В области строительства системы линейных алгебраических 

уравнений можно встретить, например, при решении следующих 
инженерных задач: 

 Определение реакций в задачах сопротивления материалов, 

 Решение системы уравнений метода сил и метода перемещений 

при расчетах статически неопределимых конструкций в задачах 
сопротивления материалов и строительной механики. 

 Как отдельный этап решения разнообразных 
дифференциальных уравнений численными методами – методом 

конечных разностей, методом конечных элементов и др. 

 Как отдельный этап решения линейных задач оптимизации. 
В общем виде система линейных алгебраических уравнений 

имеет вид: 










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332211
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, 

где n  - порядок системы уравнений, равный числу уравнений и 

числу искомых величин; 1x , 2x , … nx  - искомые величины; 11a , 12a , 

… nna  - известные численные множители перед искомыми 

величинами, 1b , 2b , … nb  - «свободные» от искомых величин 

численные значения. 

Цель решения системы линейных алгебраических уравнений – 

отыскание величин 1x , 2x , … nx , удовлетворяющих всем 

уравнениям системы. 
Пример системы линейных алгебраических уравнений: 
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, 
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где порядок системы линейных алгебраических уравнений равен 4; 

a , b , c , d  - искомые величины; 1011 a , 212 a , 113 a , 

114 a , 221 a , 2022 a , 023 a , 224 a , 031 a , 332 a , 833 a , 

534 a , 541 a , 342 a , 143 a , 644 a  - численные множители 

перед искомыми величинами; 121 b , 132 b , 33 b , 04 b  - 

«свободные» от искомых величин численные значения. 

 Часто для упрощения описания преобразований системы 
линейных алгебраических уравнений ее представляют в матричном 

виде: 

    bxA  , 

где для описанного выше примера: 
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A  - матрица численных множителей перед 

искомыми величинами; 
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12

b  - вектор «свободных» от искомых величин численных 

значений. 
Цель решения системы линейных алгебраических уравнений в 

матричном виде  – отыскание неизвестного вектора  x . 

 Для решения систем линейных алгебраических уравнений 

разработано множество различных методов решения. Ознакомиться 
с некоторыми из них можно в книгах [1] – [3]. 

Наиболее известный и часто используемый метод решения систем 

линейных алгебраических уравнений – метод Гаусса. 
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2. Решение системы линейных алгебраических уравнений 

Найти решение системы линейных алгебраических уравнений 

методом Гаусса можно, например, используя специальную команду 

системы Maple – «solve».  
Исходную систему уравнений записываем виде отдельных 

командных блоков: 

>  
   (1) 

>  

    (2) 

>  

    (3) 

>  

   (4) 

Для решения системы уравнений вводим команду «solve» с 

параметрами: 
> solve([(1),(2),(3),(4)],[a,b,c,d]) 

 

В качестве параметров команды в круглых скобках 

записываются: [(1),(2),(3),(4)] – список ссылок на строки с 

решаемыми уравнениями, перечисленными  через запятую. В 

списке может быть любое количество ссылок на уравнения 

(вводимых через Ctrl+L), или сами уравнения, перечисленные через 

запятую. [a,b,c,d] – список искомых величин, перечисленных через 

запятую. Их число должно соответствовать количеству уравнений в 

первом списке. 

Результат решения системы уравнений – значения искомых 

величин выводится в двойных квадратных скобках через запятую: 

 

Однако, поскольку система Maple не выводит значения 

дробных числе в виде привычных нам десятичных дробей, 
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приходится команду «solve» включать в состав команды «evalf»: 
> evalf(solve([(1),(2),(3),(4)],[a,b,c,d])) 

 

Как видно, в этом случае результат выведен в виде 

десятичных дробных чисел. 

Система Maple так же позволяет найти решение системы 
линейных алгебраических уравнений, записанной в матричном 

виде следующим образом: 

> 

 

 

> 

 

 

>  

 

> A X=B  

 

Для решения такой системы уравнений используется команда 

«LinearSolve» из библиотеки команд «LinearAlgebra»: 

> X=LinearAlgebra[LinearSolve](A, B) 
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Здесь в качестве параметров команды вводятся названия 

матриц A и B. 
Результат, который выводится командой, записан в виде 

вектора, где значения записаны в том же порядке, как и в векторе 

искомых величин X. 
Если нужно вывести результат в виде десятичных дробей, 

необходимо использовать команду «evalf»: 
> X=evalf(LinearAlgebra[LinearSolve](A, B)) 

 

 

3. Задание для самостоятельного решения 

Система алгебраических уравнений представляет собой набор 
уравнений равновесия конструкции, изображенной на рисунке, и 

служащий для определения опорных реакций: 

021  FVV ; 

0
22

2  cVbH
a

aqM
c

F ; 

,0)(

22
1





abH

cV
c

FM
a

aq
 

где  
a=4,  

b=1,  

c=3,  
q=10+N/2,  

F=25–N,  

M=5+N  
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N – номер варианта (задается преподавателем). 

H, V1, V2 – искомые опорные реакции. 
 

q 

F 
M 

c 

b 

a 

c/2 

V1 

V2 

H 

 
Рис.12 Расчетная схема рамы. 

Необходимо:  
1. решить систему уравнений методом в Maple с использованием 

команды «solve»; 
2. решить систему уравнений методом в Maple, записав ее в 

матричном виде. 

Результат в виде файла Maple с решением необходимо 
передать преподавателю для проверки. 
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3. Математические модели, включающие в себя  проблему 

собственных значений. Методы решения проблемы 

собственных значений. 

1. Общие сведения о задачах на собственные значения 

Пример задачи на собственное значение – решение  системы 

из трех уравнений вида: 

132 54 xxx  ; 

2321 322 xxxx  ; 

3321 527 xxxx  . 

Цель решения системы - найти значение параметра λ (или 

набор значений λ) и соответствующие ей вектор (векторы) {x}={x1, 

x2, x3,} 
Параметр λ в таких задачах называется собственным 

значением (или собственными значениями), а вектор {x} – 

собственный вектор (собственные векторы). 
Для одной и той же системы решений существует несколько, 

т.е. имеются несколько значений λ и {x}. Число собственных 

значений равно порядку системы уравнения. 
Задачи на собственные значения часто записывают в 

матричном виде: 

     xMxA   или     xxA  , 

где  [A] и [M] – матрицы коэффициентов при неизвестных x. 
В области строительства задачи на собственные значения можно 

встретить в: 

1. задачах оценки устойчивости конструкции; 

2. задачах определения частот свободных колебаний 

конструкций; 

3. задачах определения экстремальных значений – моментов 

инерции, главных напряжений. 

В первом случае параметр λ – имеет смысл коэффициента 

запаса по устойчивости, а {x} – определяет перемещения точек в 

момент потери устойчивости (форму потери устойчивости).  
В задаче по определению собственных колебаний 

конструкции параметр λ связан с  – собственной частотой 
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колебаний, а {x} – определяет перемещения точек при колебаниях 

(форму колебаний). 

В третьей задаче параметр λ – экстремальные значения для 
моментов инерции или напряжений. Коэффициенты матрицы [A] – 

значения моментов инерции или напряжений в рассматриваемой 

системе координат. Здесь проявляется свойство собственных 
значений – они соответствуют экстремальными значениям чисел, 

составляющих матрицу [A]. 

2. Пример решения задачи на собственные значения. 

В книге [9] приводится задача расчета балки с тремя массами 

(тремя степенями свободы) на свободные колебания (см. рис. 13). 
 

l 

M M M EJ, m 

 
Рис. 13. Расчетная схема балки. 

Задача о свободных колебаниях в данном случае приводится к 
виду: 

    iii YYA  , 

где M
l

EJ
i

2

3
3888   - собственные значения, через которые можно 

определить частоты свободных колебаний балки  зная параметры 

балки E, J, l, M;  iY  - соответствующие собственным значениям 

векторы прогибов в точках расположения масс 3/mlM  , задающие 
формы колебаний балки. 

Цель решения задачи – отыскать все i  и   iY . 

Вектор [A] для рассматриваемой расчетной схемы имеет вид: 

 


















253917

398139

173925

A . 
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3. Решение задач на собственные значения 

Решить задачу на собственные значения можно, например, с 

использованием расчетной системы Maple, применив процедуру 

«Eigenvectors» библиотеки «LinearAlgebra».  
Для этого необходимо подключить библиотеку, набрав и 

выполнив команду «with(LinearAlgebra)». Затем, записать: 

Eigenvectors(матрица[A], матрица [M]).  
В нашей задаче расчета балки на свободные колебания 

матрица [M] не используется, поэтому ее вводить не требуется. В 
результате мы должны набрать: «Eigenvectors(A)». 

Решение задачи в Maple ведется с использованием 

комплексных чисел. Поэтому в результате могут появиться числа, 
содержащие мнимую часть (цифры 0 умноженные на буквы I). Для 

отображения результатов в нормальной форме необходимо 

выполнить его упрощение командой simplify([результат команды 
Eigenvectors]). 

Результат представляет собой вектор собственных значений и 

матрицу собственных векторов. Каждый столбец матрицы 
собственных векторов является собственным вектором. Порядок 

следования собственных векторов соответствует порядку 

следований собственных значений. 
Командные строки и результат, отображаемый в Maple для 

рассматриваемой задачи приведен на рис. 2. Поскольку в 

результатах, получаемых после применения команды 
«Eigenvectors» не присутствуют комплексные числа, 

необходимости в использовании команды «simplify» не возникло. 

Как видно на рисунке 14, результат решения задачи – три 

собственных значения i , равные 8, 3 и 120 (записаны в виде 

вектора) и три соответствующих им собственных вектора  iY : 


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, записанные  в виде столбцов матрицы результата.  

По значениям i  могут быть определены частоты колебаний балки: 

m

EJ

l21
354.62

 , 
m

EJ

l22
184.38

 , 
m

EJ

l23
859.9

 . 
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Рис. 14. Решение задачи на собственные значения в Maple 

Формы колебаний балки, соответствующие этим частотам могут 

быть изображены по векторам  iY  как показано на рисунке 15. 

 
Рис. 15. Формы свободных колебаний балки. 

4 Задание для самостоятельного решения 

Решить задачу на собственные значения вида: 
[A] {X}=λ [M] {X},  

где {X} – искомый собственный вектор задачи, λ – искомое 

собственное значение, [A] и [M] – матрицы задачи:  
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N – номер варианта, выдаваемый преподавателем. 
Определить значения λ и набор векторов {X}. 

Результат в виде файла Maple с решением необходимо передать 

преподавателю для проверки. 
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4. Математические модели, включающие в себя  нелинейные 

алгебраические уравнения. Методы нахождения решений  

нелинейных алгебраических уравнений 

1. Общие сведения о задачах, включающих в себя нелинейные 

уравнения 

Нелинейные уравнения часто встречаются в инженерной 

практике. Это уравнения, в которых неизвестная величина входит в 

состав тригонометрических, логарифмических, степенных и др. 
видов функций, отличных от линейной.  

Примеры нелинейных уравнений с неизвестной величиной x: 

x
2
-1=0,  

x
3
-(1+x)

2
-1=0,  

0
)1( 2




x

x
, 

04 1 x ,  

1))(lg()1sin(  xtnx . 

Цель решения таких уравнений - найти значение неизвестной 

величины (в приведенных выше уравнениях – «х»), которое 

превращает уравнение в тождество (т.е. левая и правая части 
уравнения будут равны друг другу).  

При решении нелинейных уравнений необходимо иметь 
ввиду, что в большинстве случаев они имеют не одно, а несколько 

решений (например, квадратные уравнения имею два решения, 

кубические - три). Иногда число решений может быть бесконечно 
(например, часто такое встречается в уравнениях, содержащих 

тригонометрические функции). 

Некоторые виды нелинейных уравнений могут быть решены 
точно, аналитически. Например, квадратные, кубические 

уравнения, тригонометрические уравнения простого вида и др., 

изучаемые в куре математике, высшей математики.  
Для более сложных уравнений, которые невозможно решить 

аналитическими методами, можно использовать численные, 

приближенные методы решения. Однако, они, как правило, дают 
возможность определить только одно из решений нелинейного 

уравнения. Решение получается в виде числа, а не в виде формулы 
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(в отличие от аналитических методов), и с некоторой 

погрешностью, которая зависит от выбранного метода. 

С некоторыми численными методами решения нелинейных 
уравнений (метод половинного деления, Ньютона и др.) можно 

познакомиться в книгах [1] – [3]. 

2. Пример задачи, включающей нелинейное уравнение. 

Задача подбора размеров поперечных сечений элементов 
центрально сжатых стальных конструкций, исходя из условия 

устойчивости, является нелинейной задачей. Согласно п.7.1.3 СП 
16.13330.2011 «Стальные конструкции» [8], расчет на устойчивость 

выполняется по формулам: 

          (1) 

при  коэффициент  , где 

, и
  

, 

при  коэффициент 1. 

Значения коэффициента  следует принимать не более 7,6/ λ
2
 

при значениях условной гибкости свыше 3,8; 4,4 и 5,8 для типов 
сечений соответственно а, b и с. 

Радиус инерции i и гибкость определяются по формулам: 

,  

Рассмотрим подбор сплошного квадратного сечения (тип 
сечения b) с размером стороны «а». 

Площадь поперечного сечения и момент инерции находятся в 

этом случае как: 

, . 

Для данного сечения коэффициенты: 

,  

Примем физико-механические характеристики стали: 
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 Па,  Па. 

 

Нагрузка на стержень: N= 100000 Н 

Расчетная длина элемента:  м. 

 Цель решения задачи – найти наименьшее значение параметра 
«а», удовлетворяющее условию (1). 

 

3. Решение задачи, включающей нелинейное уравнение 

Решить нелинейную задачу можно с использованием 

расчетной системы Maple, применив процедуру «solve» для 

отыскания аналитического решения или «fsolve» для отыскания 
решения численными методами. 

Предварительно задачу необходимо записать в виде набора 

формул. Поскольку Maple позволяет решать нелинейные 
уравнения, записанные только в виде равенства, вместо формулы 

 примем: . Кроме того, это соответствует 

цели нашей задач- найти минимальное значение «а». 

Для записи набора формул для вычисления коэффициента  в 

зависимости от значений параметра , используем кусочно-

непрерывную функцию «piecewise». В качестве параметров этой 

функции, записанных в скобках, выступают пары выражений, 
записанные через запятую:  

условие в виде неравенства и значение функции, которое 

вычисляется при выполнении неравенства. Например, выражение: 

 

Оно соответствует выражениям: 

 7,6/ λ
2
 при  

 

при  

1 при  
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Описанную в виде набора формул задачу преобразуем в одну 

формулу путем подстановок одних формул в другие, например, при 

помощи процедуры  «subs» (описание процедуры смотри в 
лабораторной работе №1). 

Для поиска решения уравнения команда «solve» записывается 

в виде: 
> solve((1), a) 

В качестве параметров команды в круглых скобках приняты: 

(1) –ссылка на строку с решаемым уравнением (вместо ссылки 
можно записать и само уравнение). Второй параметр – обозначение 

искомой величины – «a». 

Система Maple не всегда может отыскать аналитическое 
решение уравнения. В этом случае после запуска процедуры 

выдается или соответствующее сообщение, или программа может 

длительное время производить расчет, не выдавая никакого 
результата. В последнем случае расчет можно прервать, нажав на 

панели инструментов кнопку . 
Для поиска решения уравнения численными методами 

вводится команда «fsolve» в виде: 

> fsolve((1), a, 0..1) 
В качестве параметров команды в круглых скобках 

записываются: (1) –ссылка на строку с решаемым уравнением 

(можно записать и само уравнение). Второй параметр – 
обозначение искомой величины – «a». третий параметр – диапазон, 

в котором осуществляется поиск решения, т.е. значение величины 

«a» отыскивается в пределах от 0 до 1. 
Командные строки, которые должны быть введены и 

результат, отображаемый в Maple при решении рассматриваемой 
задачи приведены ниже.  

Описание задачи в виде набора формул: 

>  
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>  

 

>  

 

>  

 

>  

 

>  

 

>  

 

Запись задачи в виде одной формулы. Подстановка формул 

(2)-(8) в формулу (1).  
>  
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Значения параметров задачи: 

>  

 

>  

 

>  

 

>  

 

>  

 

>  

 

>  

 

Подстановка параметров (10) – (16) в формулу (9): 

>  
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Решение задачи численными методами. поиск ведется в 

диапазоне значений а от 0 до 1: 

>  

 

Как видно, результат решения задачи – значение параметра 

а=0,05917729424 м. 

 
5 Задание для самостоятельного решения 

Решить задачу, описанную выше, но для сечения в виде 

прямоугольника с отношением сторон: 
 

Площадь и момент инерции поперечного сечения 

определяются по формулам: 

, 

. 

Здесь в качестве момента инерции взят минимальный момент 
инерции. 

Все остальные параметры принять такими же, как было 

описано в примере решения нелинейной задачи. В  качестве 
искомой величины принять  ширину сечения «b». 

Результат в виде файла Maple с решением необходимо 

передать преподавателю для проверки. 
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5. Математические модели, включающие в себя 

аппроксимирующие функции. Интерполяция и экстраполяция 

значений. Методы интерполяции и экстраполяции. 

1. Общие сведения о задачах, требующих аппроксимации, 

интерполяции или экстраполяции значений. 

Очень часто в инженерной практике, в области научных 

исследований приходится сталкиваться с данными, записанными в 

виде таблиц. Они могут служить описанием сложных 
зависимостей, полученных экспериментальным путем, могут 

представлять собой набор значений какой-либо сложной, 

нелинейной математической функции, которую обычно 
записывают в виде таблицы с целью облегчения проведения 

инженерного расчета. С табличными данными часто сталкивается 

инженер, проводящий расчеты по СП, СНиПам. 
Значения функции в таблицах приводятся для определенных, 

фиксированных значений аргумента. В то же время, в процессе 

вычислений часто возникает необходимость вычисления 
промежуточных значений. Для этого применяют различные методы 

интерполяции – методы приближенного нахождения 

промежуточных значений функции. 
Если в процессе вычислений необходимо получить значение 

функции при значении аргумента, выходящего за крайние значения 

таблицы, применяют методы экстраполяции, которые 
основываются на тех же принципах, что и методы интерполяции. 

Если необходимо записать табличную функцию в виде 

аналитической функции (математической формулы), применяют 
аппроксимацию. Необходимо иметь в виду, что в большинстве 

случаев, полученная таким путем аналитическая формула будет 

только приблизительно (с некоторой погрешностью) описывать 
реальную функцию. Однако для практических целей этого бывает 

вполне достаточно.  

Кроме того, большинство методов интерполяции и 
экстраполяции основаны на аппроксимации табличной функции. И 

здесь так же необходимо иметь ввиду, что найденные этими 
методами значения будут содержать некоторую погрешность. 
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С методами интерполяции, экстраполяции, аппроксимации 

можно познакомиться в книгах [1] – [4]. 

2. Пример задачи аппроксимации табличной функции и 

интерполяции ее значений. 

Значения табличной функции f в зависимости от значений 
аргумента x  представлены в таблице 1. 

 

 
Таблица 1. 

x f (x) 

100 0,24 

200 0,18 

300 0,16 

400 0,14 

600 0,11 

800 0,09 

Предположим, необходимо аппроксимировать данную 

функцию с использованием линейного сплайна. С ее помощью 

вычислить значение f в точке, где x=344 (выполнить 
интерполяцию). 

 

3. Решение задачи 

Решить задачи аппроксимации, интерполяции и 

экстраполяции можно с использованием расчетной системы Maple.  

Для аппроксимации функции f(x) сплайном воспользуемся 
процедурой Maple «spline». Для этого необходимо записать в 

командной строке: 
 

Здесь первый список значений (в квадратных скобках) 
соответствует значениям аргумента х, второй список – 

соответствующие им значения табличной функции. Третий 

параметр «х» - обозначение аргумента. Последний параметр задает 
вид сплайна: «linear» - линейный, «quadratic» - квадратичный, 

«cubic» - кубический, «quartic» - 4-й степени. 

В результате выполнения этой процедуры создается кусочно-
непрерывная сплайн-функция, описывающая функцию f(x) и 
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позволяющая применять к ней средства математического анализа, 

вычислять значения функции в любых точках, строить график и 

т.д.: 

 

Например, для вычисления значения функции f в точке с 
х=344 необходимо ввести в командную строку:  

eval(f,x=344) 
Здесь параметр «f» – наименование функции (которая была 

задана в предыдущей строке), «x=344» - название аргумента 

функции f и его значение в нужной нам точке. 
В результате получим: 

0.1512000000 

Это число соответствует значению функции в точке x=344, 
определенному с помощью линейной интерполяции (поскольку 

сплайн – линейный). 

 

6 Задание для самостоятельного решения 

Решить задачу описанным выше способом для табличной 
функции φ(λ) (см. таблицу 2) и линейной интерполяцией найти 

значение φ при λ=1,3 и λ=0,3. 

Результат в виде файла Maple с решением необходимо 
передать преподавателю для проверки. 

Таблица 2. 

λ φ(λ) 

0,4 0,999 

0,6 0,994 

0,8 0,981 

1 0,968 

1,2 0,954 

1,4 0,938 

1,6 0,920 

1,8 0,900 

2 0,877 
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6. Математические модели на основе  дифференциальных 

уравнений. Методы нахождения решений дифференциальных 

уравнений 
 

1. Общие сведения о задачах, включающих в себя 

дифференциальные уравнения 

Дифференциальные уравнения очень часто являются основой 

математических моделей, описывающих реальные, достаточно 

сложные физические процессы – начиная от процессов деформации 
строительных конструкций, заканчивая процессами движения 

жидкости, газа в инженерных системах. 

Отдельные виды дифференциальных уравнений можно 
решить, получив точное, аналитическое решение методами, обычно 

изучаемыми в курсе высшей математики. Однако существует 

большое число практически важных видов дифференциальных 
уравнений, для которых аналитические методы решения пока не 

разработаны. Для получения решения таких уравнений 

применяются различные приближенные, преимущественно 
численные методы решения. С некоторыми их них можно 

ознакомится в книгах [1] – [4]. 

Попробуем применить один из достаточно распространенных 
методов решения дифференциальных уравнений – метод конечных 

разностей (или метод «сеток») к модели изгибаемой балки, 

сформулированной в виде дифференциального уравнений. 
 

2. Пример математической модели, записанной в виде 

дифференциального уравнения. 

Процесс деформации конструкций в виде изгибаемого стержня 

(балки) (см. рис. 16) можно описать дифференциальным 
уравнением изгиба: 

  xq
dx

xwd
EJ z 

4

4 )(
, (1) 

где w(x) - функция, описывающая распределение прогибов балки 

вдоль ее оси,  

q(x) –функция, описывающая закон распределения нагрузки вдоль 
оси балки, 
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E – модуль упругости материала балки,  

zJ  - момент инерции поперечного сечения балки. 
 

L 

qA qB 

w(x) 

x 

 
Рис. 16. Расчетная схема балки 

Данное уравнение позволяет единообразно описать работу любой 
балки под нагрузкой – с различным расположением, количеством, 

видами опор, переменной формой сечений и распределением 

нагрузки. 
Для получения частного, конкретного решения, к уравнению 

(1) необходимо добавить граничные условия. Граничные условия 

задачи задаются в точках, где расположены опоры. Для схемы, 
изображенной на рисунке 1 - в точках с координатой x=0 и x=L: 

Жесткая заделка: 0
 x

)(

0

2

2



x
d

xwd
,
  

0)(
0


x
xw . (2) 

Шарнирная опора: 0
 x

)(


Lxd

xdw
,  

0)( 
Lx

xw . (3) 

  Здесь черта со значением координаты x, записанным внизу 

обозначает, что выражение вычисляется в точке с указанной 

координатой. 
Конкретизируем задачу (модель). 

Предположим, что поперечное сечение балки – прямоугольник 
высотой 100 мм и шириной 50 мм. Момент инерции такого сечения 

равен 61017.4 zJ  м
4
. Нагрузка на балку приложим 

распределенную, меняющаяся по линейному закону (рис.1). Такой 
закон распределения описывается формулой: 

   x
L

qq
qxq AB

A


 , (4) 

где x – координата точки, где определяется интенсивность 

нагрузки, Aq , Bq  - интенсивность распределенной нагрузки в начале 

и конце балки соответственно. 
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Данная модель позволяет определить прогиб балки в любой 

точке. Предположим, что необходимо определить прогиб балки в 

середине балки и на расстоянии L
4

1
 от опор. 

3. Решение задачи, включающей дифференциальное уравнение 

Решить нелинейную задачу можно с использованием 

расчетной системы Maple. Для этого существует специальная 

процедура – «dsolve», реализующая метод конечных разностей. 
Предварительно необходимо записать дифференциальное 

уравнение изгиба балки (1) и граничные условия (2), (3), каждое в 

отдельной командной строке. В правую часть уравнения изгиба 
балки необходимо сразу подставить функцию q(x), пользуясь 

выражением (4) и значения всех известных величин – E, zJ , L, Aq , 

Bq . Для ввода дифференциальных выражений можно использовать 

левую панель программы, раздел «Expression». Для ввода 

граничных условий лучше использовать функцию «eval» в 

следующем виде: 
eval(w(x),x=0)=0 

Здесь записано граничное условие для функции w(x) в точке, 

где х=0: 
0)(

0


x
xw  

Решается задача после ввода в командную строку процедуры в 

следующем виде: 

R := dsolve(convert([ссылки на диф. уравнение и все граничные 
условия через запятую], D), numeric). 

Здесь перед применением процедуры «dsolve» задача 

приводится к форме записи с использованием дифференциального 
оператора «D» (этого требует Maple). Процедура «dsolve» 

применяется с параметром «numeric», что заставляет ее решать 

задачу численным методом – методом конечных разностей. 
Результат решения задачи - функция w(x), сохраняется в 

переменной R. Построить ее график в зависимости от положения 

точки по длине балки можно командой plots[odeplot](R, [x, w(x)], 
0..L). 

Для вывода значений прогибов и их производных в нужных 
нам точках (например, x=0 L, x=0.25 L, x=0.5 L) необходимо ввести 
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последовательно в разные командные строки Maple выражения: R(0 

L), R(0.25 L), R(0.5 L). 

Пример решения задачи в Maple приведен ниже: 

>  

 

>  

 

>  

 

>  

 

>  

 

>  

 

>  

 

>  

 

>  

 

>  
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>  

 

>  

 

>  
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7 Задание для самостоятельного решения 

Решить задачу, описанную выше, но со следующими 

исходными данными: 

N – номер варианта (выдается преподавателем). Длина балки 
L=(5+N/10) м.  

Модуль упругости материала из которого изготовлена балка: E=2 

10
11

 Па - для четного N, E=0.6 10
11

 Па - для нечетного N. 
Значения интенсивностей: qA=(1+N/5) 1000 Н/м, qB=(5-N/5) 1000 

Н/м. 
Результат в виде файла Maple с решением необходимо 

передать преподавателю для проверки. 
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7. Математические модели, включающие в себя  задачи 

оптимизации. Методы поиска оптимальных решений. 

1. Общие сведения о задачах оптимизации. 

Цель решения задачи оптимизации – нахождение таких 
параметров проектируемого объекта или таких параметров 

технологического процесса, которые сделали его наилучшими с 

какой-то точки зрения.   
В качестве критерия, по которому оценивается качество 

полученного в результате объекта или процесса могут выступать: 
стоимость, расход материалов (или их объем), продолжительность 

протекания процесса и т.д. 

В качестве искомых параметров проектируемого объекта (или 
процесса) могут выступать: размеры объекта, места расположения 

его отдельных элементов, форма объекта, свойства материалов их 

которых они выполнены, продолжительность,  интенсивность 
обработки при выполнении технологического процесса, 

дозирование материалов или компонентов в ходе выполнения 

технологического процесса и т.д. 
Кроме того, в процессе проектирования должны быть учтены 

определенные ограничения, связанные как со значениями искомых 

параметров (например, размеры элементов не могут быть 
отрицательными, и в тоже время, не могут превышать 

определенных, заранее установленных величин), так и с 

физическими особенностями самого объекта, материалов, которые 
применяются для его изготовления (например, ограничение по 

нагрузке, которую может воспринять элемент конструкции без его 

разрушения -  ограничение по прочности).  
Все эти условия задачи должны быть формализованы и 

представлены в виде математической модели, которая включает в 

себя: 

1. Функцию цели – математическую формулу или алгоритм, 

которые позволяют оценить качество полученного объекта 

(процесса) и сравнить его с другими вариантами. Функция 

цели зависит от параметров проектируемого объекта или 

процесса. 
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2. Ограничения – математические формулы, записанные в 

виде равенств или неравенств (или выполняющие 

аналогичную роль алгоритмы). В процессе поиска 

оптимального решения данные равенства или неравенства 

должны быть строго выполнены. Они формируют границу 

области поиска оптимального решения. 

Кроме того, для функции цели необходимо выбрать, какое еѐ 

значение в сравнении с другими является наилучшим – 
максимальное или минимальное (например, для функции цели, 

являющееся стоимостью объекта, наилучшим является его 

минимальное значение; для функции цели, отражающей 
производительностью технологического процесса – его 

максимальное значение). В зависимости от этого, задачи 

оптимизации разделяются на задачи поиска минимума или поиска 
максимума. 

Сформулированные в такой форме задачи называют еще 

задачами математического программирования (это термин не 
следует путать c программированием – процессом составления 

программы для компьютера). 

Для решения задач оптимизации (математического 
программирования) разработано множество методов. Эти методы, в 

зависимости от того, какой вид имеют функция цели и ограничения 

– линейный или нелинейный, подразделяют  на методы линейного 
математического программирования и методы нелинейного 

математического программирования. 

Более подробно с отдельными задачами оптимального 
проектирования и методами их решения можно познакомиться в 

книгах [1] – [4]. 

2. Пример задачи оптимизации. 

Найти оптимальный проект двухстержневой несущей 

конструкции, показанной на рисунке 17. Расстояние l= 3 м, масса 

подвешенного груза F = 10000. Стержни выполнены из стали с 
расчетным сопротивлением R=230 МПа. Условно будем полагать, 

что длина стержней и нагрузка на них таковы, что потери 

устойчивости для них наблюдаться не будет.  
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Рис. 17 

Предполагается, что в ходе поиска оптимального решения 
будут подбираться следующие параметры конструкции (параметры 

проектирования): α – угол наклона первого стержня, A1, A2 – 

площади поперечного сечения стержней 1 и 2 соответственно 
(форма и размеры сечения в задаче не уточняются).  

Необходимо найти наилучшее сочетание этих параметров, при 

котором объем материала, из которого изготовлены стержни, был 
минимальный (и, соответственно, масса и стоимость). При этом 

конструкция должна быть прочной и выдерживать приложенную 

нагрузку. 
Математическая модель этой задачи имеет вид: 

1. Функция цели: min
cos

21 


 lA
l

AV  

2. Ограничения задачи: 

R
A

S


1

1 ; 

R
A

S


2

2 . 

Здесь S1 и S2 – усилия в стержнях 1 и 2 соответственно. Их 
можно определить из условий равновесия: 

  0cossin:0 2 FSY ; 

  0sin:0 1SF  (здесь ось υ – перпендикулярна стержню 

1). 

Выразив усилия из этих выражений и подставив их в 

ограничения по прочности, заменив знак неравенства на знак 
равенства, получим ограничения задачи окончательно в виде: 

0
sin

1 


RA
F

; 
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02  RAFctg . 

 
 

3. Решение задачи 

Решать задачи оптимизации можно с использованием 
расчетной системы Maple.  

Для этого существует специальная библиотека Maple 

«Optimization». Из набора команд этой библиотеки рассмотрим 
команду «NLPSolve», предназначенную для решения задач 

нелинейного программирования, т.е. задач в наиболее общей 

постановке. Для ее использования необходимо записать в 
командной строке: 

Optimization[NLPSolve](ссылка на функцию цели, 

{перечисленные через запятую ссылки на ограничения}, 

перечисленные через запятую границы изменения параметров 

проектирования) 

Здесь количество ограничений и переменных проектирования 
может быть любым, в зависимости от решаемой задачи. 

Ограничения должны быть записаны в виде равенств или 

неравенств. Границы изменения параметра записываются в виде:  
обозначение параметра = минимальное значение .. максимальное 

значение. 

Границы для параметра проектирования можно не записывать, 

если он может меняться от -∞ до +∞. 

Процедура по умолчанию отыскивает такую комбинацию 
параметров проектирования, при котором функция цели будет 

минимальна (с учетом ограничений). Если требуется найти 

максимум функции цели вместо минимума, необходимо в конце 
строки, после последнего параметра через запятую записать слово 

‘maximize’. 

Пример вызова процедуры оптимизации: 
Optimization[NLPSolve]((1), {(2),(3),(4)}, a=0..10, b=2..3) 

Здесь (1) – Maple-ссылка на первую строку, где записана 

формула для вычисления функции цели; (2),(3),(4)  - ссылки на 
строки, где записаны три ограничения задачи; a=0..10, b=2..3 – 

границы изменения параметров проектирования а – от 0 до 10, b – 

от 2 до 3; для третьего параметра границы не установлены, поэтому 
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он здесь не упомянут, и может принимать значения от -∞ до +∞. 

Будет отыскиваться  точка минимума функции цели  (с учетом 

ограничений). 
После запуска команды, если Maple находит решение, то на 

экране будет отображен результат в виде: 

[0.368925559132882, [a=0.955899349455908, 
b=0.00532278533443, c=0.000307057845268]] 

Здесь первое число 0.368925559132882 - значение функции 

цели (критерия оценки) для найденного процедурой оптимального 
решения. Далее в квадратных скобках найденные оптимальные 

значения параметров проектирования – a,b,c.  

 
Решение задачи, сформулированной ранее, с использованием 

Maple осуществляется следующим образом: 

 

Функция цели 

>  

 

Ограничения 

>  

 

>  

 

Значения известных параметров 

>  

 

>  

 

>  
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Подстановка известных параметров в функцию цели и 

ограничения  
>  

 

>  

 

>  

 

Решение задачи 

>  

 

Перевод угла из радиан в градусы 

>  

 

 

Результат решения задачи – найденный оптимальный угол 
α=54.76899835 градусов и площади поперечного сечения стержней 

A1 = 0.0000534093293682323 м
2
, A2 = 0.0000310193052037333 м

2
. 

 

8 Задание для самостоятельного решения 

Решить задачу описанным выше способом, при  значениях F = 

5000, l= 4 м. 

Результат в виде файла Maple с решением необходимо 
передать преподавателю для проверки. 
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